This book is dedicated to those who challenge the status quo and seek to show the world something it has never seen. Make your mark on the world and love what you do.
Acknowledgments

Scott Kelby—I cannot thank you enough for the opportunities you have bestowed upon me. Before I met you, I was just some kid who loved Photoshop a little too much. I never imagined this journey would take me where it has, and it was all because you saw something and gave me a chance. Thank you, Scott!

Dad & Sue—Once again, I cannot thank you enough for all that you have done to help me become the artist I am now. I hope you enjoy retiring to Orlando this year. Thanks again you for all you have done.

Mom & Mark—You guys have been supportive of every decision I have made, and have always had the right advice when I needed it. Being a fan of movies, we always have something fun to talk about. Thank you both.

Shelley Giard—You contributed to this book in more ways than you know. Your heart and passion for what you do pushes me as much as it does you. You make everyone around you smile, and I am lucky that you are my sweetness! I love you!

Dave Moser—No one has a bigger heart than this man. You are a great mentor and a great friend. Thank you for everything.

Felix Nelson—I am so very proud to work with someone as talented as Felix. I have enjoyed sharing the Down & Dirty column with you in Photoshop User magazine and look forward to collaborating more.

The Photoshop Guys—A big shout out to the gang: Matt Kloskowski, RC Concepcion, and Pete Collins. I am thankful I have a job I love and that I get to share it with you guys every day. We always find a way to make it fun.

Cindy Snyder & Kim Doty—These two definitely deserve to be wined and dined after this project. I threw a ridiculous amount of information at them to edit, but they still managed to get through it and didn’t want to break my legs. [Ed. note: Well, maybe his Wacom pen.] Thank you so much!

Jessica Maldonado—Since the last book, Jessica has transitioned into The Photoshop Girl and has become a regular on Photoshop User TV. Oh, and did I mention she is responsible for the entire look of this book? You are awesome, Jess!

Moose Peterson & Glyn Dewis—Thank you guys so much for allowing me to use your photography. I am honored to call myself a friend and fan of you both.

Brandon Ford, Mia McCormick & Peter Hurley—You guys were such good sports for helping me out with the Shabang poster. Thanks so much!

Adam Rohrmann—Thank you for providing me with an inspiring project that would become a pretty damn cool beer label. I hope others will be equally inspired by the tutorial that resulted.

Russell Preston Brown—Thanks for all the advice and opportunities over the years. Also, thanks for the monster images.

New Riders & Peachpit Press—Another big thanks to the entire gang over at Peachpit Press: Ted Waitt, Sara Jane Todd, Gary-Paul Prince, and Scott Cowlin. You guys are the ones that make learning accessible and fun! Keep up all the good work, and thanks again for this opportunity.
COREY BARKER

Corey has come a long way since obtaining his BFA in Illustration from the Ringling College of Art & Design in Sarasota, Florida, in 1996—from his first position as a graphic designer at a city newspaper, to eight years of design and print work for a large format printing and graphics company, to becoming an award-winning designer and illustrator. Corey finally made the decision to pursue his dreams in 2006, when he took a leap of faith by submitting a resume packet to a company he admired when a position became available. Because of that leap, instead of being just an attendee at the Photoshop World Conference & Expo that year, he was interviewed for a position with KelbyOne as the next “Photoshop Guy.” When he landed the job, it was a dream come true.

Since then, Corey has been the face of graphic design as an Education and Curriculum Developer for KelbyOne. He is a featured instructor for both the Photoshop World Conference & Expo and the Adobe MAX conference, and is considered to be an expert in Photoshop 3D. After becoming a contributing writer for Scott Kelby’s Photoshop CS4 Down & Dirty Tricks, Scott handed the D&D Tricks baton over to Corey and he was told to make it his own. Since that day, Corey has taught thousands of designers and photographers on the Photoshop Down & Dirty Tricks seminar tour. In December 2011, his first book, Photoshop Down & Dirty Tricks for Designers, hit the market and quickly became a bestseller.

Corey is also a contributing writer for Photoshop User magazine and Photographic Elements Techniques magazine, an Adobe Certified Photoshop Expert, and co-host of the top-rated weekly webcast Photoshop User TV.

Learn more and follow Corey online by visiting him at:

His portfolio and daily blog: CoreySBarker.com
Facebook: www.facebook.com/coreyps3D
Google+: plus.google.com/109614444934743992132
Twitter: @coreyps3D
YouTube: www.youtube.com/user/cbarker33
CHAPTER 1
This Will Help You on Your Way
Common Techniques Used in This Book

Extracting People from Backgrounds 2
Extracting Design Elements from Black or White Backgrounds 11
Some Bonus Extraction Techniques 17
Creating Custom Brushes 23
Textures, Textures, and More Textures 31
HDR Toning Trick 40

CHAPTER 2
You Have a Way with Words
Type Effects

Movable Type 46
Chalkboard Effect 54
Type in Negative Space 64
Column of Text 71
Iron Man Text Effect 79

CHAPTER 3
That Was No Accident, It Was By Design
Design FX

Branding a Brand 88
That Cool Perforated Pattern 93
Designing with Textures 106
Building a Beer Label 115
Inspired by the Gaming World 136
1. Fundamental techniques
I have noticed throughout my work, and in this book, that I use a number of different techniques rather consistently. So, instead of covering selections, brushes, and other effects over and over in every tutorial, I put some of my best practices in Chapter 1, so you can refer to them quickly instead of searching through the tutorial. These are key techniques that you will find used throughout this book and in your own work.

2. What user level is this book?
This volume of D&D Tricks is meant to be a next level book from the first one. It is categorized as Intermediate to Advanced because a number of the projects in the book require a strong knowledge of Photoshop, especially with the 3D chapter. Now, that doesn’t mean you are excluded if you are a beginner. When I was a beginner, I bought advanced books to: (a) see what was possible, and (b) because I figured that the best way to become advanced was to start playing around with advanced techniques. Makes sense, huh?
3. Supplemental video tutorials

Some of the final images in this book have some finishing touches that are not covered in detail in the tutorial. However, just in case you are curious about how I added those finishing touches, you can view these free supplemental video extras over at the book’s companion webpage at kelbyone.com/books/dd2.

4. What about the fonts?

As in the previous book, I tried to use fonts that you should already have, but I sometimes like to play around with more specialized fonts. Check out one of my favorite places to find new fonts: Dafont.com. They are free for you to download and play around with. Just be wary of using them for commercial projects without permission and, where possible, make a donation to the font creator. It’s not easy to make a font. Show them you appreciate their hard work.

Also, if you are a Creative Cloud subscriber, you have access to the Adobe Typekit, which is an online font service that allows you to sync selected fonts to your Creative Cloud apps.
5. What version of Photoshop is required for this book?
While a majority of the techniques in the book can be done in earlier versions of Photoshop, some features used are found only in more current versions. For instance, the 3D chapter requires CC or CS6. The other chapters utilize features that allow you to go as far back as CS4, or even CS3. Anything earlier than that might pose a bit of a challenge.

6. What file size should I use?
I always feel this needs to be addressed, because it can confuse some people. Throughout this book, you’ll notice I create the files at small dimensions and low resolutions. I do this for several reasons, the most obvious being speed. And, since I was creating these images for the book, they did not need to be super-sized. Just remember: if you are re-creating these effects (with your own images) for actual print, then be sure to build them high-res.
7. Start file and image downloads
You can certainly follow along with the book and create your own images, but you can also download the start files, as well as all of the project images, from the book’s companion webpage at kelbyone.com/books/dd2. That way, you can follow along with exactly how it is done in the book, and then once you have the technique mastered, you can go and experiment with your own images.

8. Using stock images
Many of the images in this book are from stock photography services like Fotolia and iStock. They each have a vast collection of stock images, as well as graphics, and even video clips. I like Fotolia because they have a subscription model that allows for 10 high-res downloads per day. Stock images can be a designer’s best friend, but I still rely on shooting a lot of things myself, especially with my iPhone. Yes, my iPhone is one of the best design tools I own. Whatever your source of images, make sure you start building a library of everything. I have folders of textures, people, skies, objects—all sorts of things that I might find useful. You never know!
9. Project-based tutorials
Like the last book, I have a number of short techniques that yield some impressive effects. What I wanted to do this time around is actually have some start-to-finish projects that you can really sink your creative teeth into. These projects can be up to three times as long as other tutorials, but they also contain numerous techniques within them that you can extract and use on other projects. Sometimes just doing things in context really helps you see how it all comes together.
10. What I hope you get out of this book

This book is meant to inspire through process. I have always felt that seeing what is possible can and will push you to your best potential, but also that doing it while you are learning it just solidifies the knowledge in your brain. The same goes here in the pages of this book. If you are a relative newbie to Photoshop, then I hope that this book can fuel you with the drive and inspiration to make it yours and to make it better. All you need are three things: motivation, patience, and a keen sense of observation of the world around you to recognize a good idea. If you are a veteran of Photoshop, then my hope is that you are able to find a new perspective, or perhaps discover something about Photoshop, or your own creative process, that you did not know before. Just remember to experiment. Almost every technique in this book was discovered by experimenting. What can you come up with?
During my time at KelbyOne, I have developed numerous relationships with prominent photographers around the world, and often find myself asking them to use their images for ideas I get when I look at their work. So, I thought it would make a good chapter in the book to use photos from some of these fantastic photographers, run them through the creative ringer, and see what comes out. The photographers who have so kindly agreed to allow us to use their images here are Glyn Dewis, Dave Clayton, and Moose Peterson. So, if you don’t do much shooting, then become friends with people that do. Most of the time, they are all too eager to give you images, or even sell them cheap, to see something cool done with them.
STEP ONE:
Start by pressing **Command-N** (PC: **Ctrl-N**) and creating a new document measuring 1000 pixels wide by 1500 pixels tall at 125 ppi. Then, press **Shift-Delete** (PC: **Shift-Backspace**) to open the Fill dialog, choose **Black** from the Use pop-up menu, and click OK to fill the background with black.

STEP TWO:
Once the main file is created, open the cloud movie file. (Yes, you can actually snag workable stills from video files here in Photoshop.) In the Timeline panel (under the Window menu), click on the playhead and scrub through the video until you find a frame you like, and then stop. All you need to do now is copy-and-paste or click-and-drag the image into the main layout.

My friend, and fellow Photoshop World instructor, Moose Peterson is most well known for his wildlife photography, but he also does some amazing aviation photography, especially with vintage war planes. Well, after seeing a couple of his images, I was inspired to make something interesting with them. It really gives you a good idea of how to look at a simple photo a little differently. Thanks, Moose!
STEP THREE:
Now, in some cases, video files may be small in dimensions like this one. In this case, it is merely an abstract sky background, so I do not mind greatly resizing the image to fit. Just press **Command-T (PC: Ctrl-T)** to bring up Free Transform. Notice, here, I also slightly rotated and positioned the clouds for the best composition. When you’re done, press **Return (PC: Enter)** to commit the change. Now we have a nice sky backdrop, but it needs a couple quick tweaks. These next couple steps aren’t entirely necessary, but since I am all about detail, why not?

STEP FOUR:
Press-and-hold the Command (PC: Ctrl) key and click on the Create a New Layer icon at bottom of the Layers panel. This will place the new blank layer under the current layer.
**STEP FIVE:**
Click on the Foreground color swatch at the bottom of the Toolbox and, in the Color Picker, set the RGB settings to R: 86, G: 112, B: 138. Click OK. Then, press **Option-Delete (PC: Alt-Backspace)** to fill the blank layer with this new color. Then, click back on the cloud layer and drop its Opacity to 75%.

**STEP SIX:**
Click on the blue-filled layer again, then click on the Add a Layer Style icon at the bottom of the Layers panel and choose **Gradient Overlay**. Set the Blend Mode to **Overlay** and make sure the Style is set to **Linear**. Click OK. The enhancements here are subtle, but this lessens the contrast while maintaining a subtle coolness in the sky.
STEP SEVEN:
Click back on the cloud layer and make a duplicate of it by pressing **Command-J** (PC: **Ctrl-J**). Press **Command-Shift-U** (PC: **Ctrl-Shift-U**) to remove the color from the duplicate layer, then change its layer blend mode to **Overlay** and drop its Opacity to 50%.

STEP EIGHT:
Double-click on the layer to open the Blending Options. In the Blend If section at the bottom, Option-click (PC: Alt-click) on the black Underlying Layer slider knob and drag it to the right to split the knob. This will allow some of the darker areas of the layer below to show through a little more. Click OK.
STEP NINE:
Click on the original cloud layer in the Layers panel, make another duplicate of it, and move it to the top of the layer stack. Press Command-Shift-U (PC: Ctrl-U) to remove the color, then change its layer blend mode to **Soft Light** and drop its Opacity to 50%. Now, go under the Image menu, under Adjustments, and choose **Hue/Saturation**. Turn on the Colorize checkbox, set the Hue to 360 and the Saturation to 30, then click OK. This will place a red cast over the image and will warm up the overall feel of the background sky. Now let’s add a plane.

STEP 10:
Here’s where we make it interesting. We have a shot here taken by Moose. When I saw this image, it just hit me what I wanted to do with it. First, we need to extract the plane from this background. So, start by pressing **Command-A (PC: Ctrl-A)** to select the entire canvas area.
STEP 11:
Now, get the Quick Selection tool (W) from the Toolbox. Here’s yet another approach to selecting, in some cases, I have found a little easier: Since the entire canvas is already selected, we are going to select by subtraction. So, press-and-hold the Option (PC: Alt) key and then start painting over the plane. You will see the selection appear to conform to the plane, but we are actually subtracting the plane from the selection. (Trust me, it will work.) Continue until the entire plane is deselected.

STEP 12:
Go under the Select menu and choose Inverse. This will flip the selection from the sky to the plane, but we’re not done yet.
STEP 13:
Get the Lasso tool (L) from the Toolbox, press-and-hold the Shift key, and draw selections around the areas of the blurred propeller (the Shift key lets you add to the existing selection). Don’t worry about being super-precise, but get as close as you can. Once you have all of the propeller areas selected, click on the Refine Edge button up in the Options Bar.

STEP 14:
Set the View pop-up menu to On Layers, which will show the transparency grid behind the selection. Then, with the Refine Radius tool (press the Left Bracket or Right Bracket key to change the size of the brush, if needed), paint over all the blue area around the propeller. Try to avoid getting in the area of the plane too much. When you’re done, you’ll see that Photoshop has magically erased the sky, leaving just the dark blur of the prop. Be sure to also paint in the area of the cockpit and any other areas where there might be some residual sky elements. Now, in the Adjust Edge section, increase the Contrast to 15, then, in the Output section, turn on the Decontaminate Colors checkbox, and choose New Layer from the Output To pop-up menu. Click OK when you’re done.
STEP 15:
Press **Command-J (PC: Ctrl-J)** a couple times to make a couple duplicates of this layer. This will fill in any subtle transparent edges that might have been created with Refine Edge. Then, Command-click (PC: Ctrl-click) to select all three layers and, from the Layers panel’s flyout menu, choose **Merge Layers**.

STEP 16:
You can now copy-and-paste or click-and-drag this image layer into the main file. Press **Command-T (PC: Ctrl-T)** to bring up Free Transform and scale it to fit in the canvas, as you see here. I also rotated it slightly to the left. Press **Return (PC: Enter)** when you’re done.
STEP 17:
Let's take care of any anti-alias noise that we might have picked up by going under the Layer menu to the very bottom, under Matting, and choosing **Defringe**. Set the Width to 1 pixel and click OK.

STEP 18:
Make a duplicate of this layer, press **Command-Shift-U (PC: Ctrl-Shift-U)** to remove the color, and then change the layer’s blend mode to **Soft Light**. Click on the Add Layer Mask icon at the bottom of the Layers panel to add a white layer mask to this layer.
STEP 19:
Get the Gradient tool (G) from the Toolbox, then, in the Options Bar, choose the Foreground to Transparent gradient from the Gradient Picker and click on the Radial Gradient icon (the second icon to the right of the gradient thumbnail). Since the blend mode makes dark areas darker, with your Foreground color set to black, just add some random gradients in the areas on the plane that got too dark to lighten the effect.

STEP 20:
Press-and-hold the Command (PC: Ctrl) key and click on the top layer’s thumbnail to generate a selection in the shape of the plane. Create a new blank layer and press Shift-Delete (PC: Shift-Backspace) to open the Fill dialog. Choose 50% Gray from the Use pop-up menu and click OK. Press Command-D (PC: Ctrl-D) to Deselect.
**STEP 21:**
Change this layer’s blend mode to **Hard Light** and then get the Burn tool (press **Shift-O** until you have it) from the Toolbox. In the Options Bar, set the Range to **Midtones** and then set the Exposure to 25%. Now, paint in areas of the plane that should be darker to help adjust the contrast, so it seems to fit in with the lighting in the sky more.

**STEP 22:**
With the same gray layer active, click on the Add a Layer Style icon at the bottom of the Layers panel and choose **Inner Shadow**. Set the Blend Mode to **Vivid Light**, then click on the color swatch and choose a hot orange color from the Color Picker, and click OK. Drop the Opacity to 25%, increase the Distance to 34 px and the Size to around 18 px, and then click on the image and drag to position the shadow manually. This will create a glow effect that will enhance the fire effects we’ll be adding in a minute.
STEP 23:
Now, get the Brush tool (B) from the Toolbox. For the fire effect, I am going to use a brush I created from a picture of a cloud. You can download this brush from the book’s companion webpage (mentioned in the book’s introduction) or use one that is similar. It just needs to be abstract with varying tones. With the brush selected, open the Brush panel (under the Window menu), click on Shape Dynamics on the left and set the Size Jitter to 100%. Then, choose Fade from the first Control pop-up menu, and set the Fade to 40. Also, set the Angle Jitter to 100%.

STEP 24:
Create a new document measuring 1500 pixels wide by 350 pixels tall at 125 ppi, and then create a new blank layer and turn off the Background layer (by clicking on the Eye icon to the left of it). Click on the Add a Layer Style icon at the bottom of the Layers panel and choose Inner Glow. Set the Blend Mode to Hard Light, then click on the color swatch and choose a hot orange color from the Color Picker, and drop the Opacity to 75%.

Continued
**STEP 25:**
Now, click on Outer Glow in the Styles section on the left to turn it on. Here, set the Blend Mode to **Screen**, and then click on the color swatch and choose a bright red color from the Color Picker. Click OK.

**STEP 26:**
Press **D**, then **X** to set your Foreground color to white. Then, press-and-hold the Shift key (to paint in a straight line) and, starting on the left side of the canvas, click-and-drag to the right. You will instantly see a fire trail. Pretty cool, huh? Do this two or three times to build the effect, as seen here.
STEP 27:
Go back to the Brush panel and, in the Shape Dynamics options, choose Off from the first Control pop-up menu. Then, click on Transfer on the left to turn it on. Choose Pen Pressure from the first Control pop-up menu, if you're using a pressure tablet. You can also choose Fade here and even adjust the Opacity Jitter amount above.

STEP 28:
Create a new blank layer and then press D, again, to set your Foreground color to black this time. Now, start painting in the smoke effect trailing off the fire effect. Just a few passes should do.
STEP 29:
Now, let's blend these two elements. With the smoke layer still selected, double-click on it to open the Blending Options. In the Blend If section, Option-click on the white Underlying Layer slider knob and drag it to the left to split it. This will allow the lighter areas below to peek through, making the fire and smoke appear to blend naturally.

![Blending Options screenshot](image1)

STEP 30:
Command-click on the fire layer to select both it and the smoke layer, then Right-click on one and choose **Convert to Smart Object** from the pop-up menu.

![Convert to Smart Object](image2)
STEP 31:
Now, bring this fire trail over to the main design file (copy-and-paste or drag-and-drop it). Press Command-T (PC: Ctrl-T) to bring up Free Transform, then click inside the bounding box, and choose Distort. Using the corner handles, reshape the object, so that the fire appears to be emerging from the exhaust vents and trails to the back. Notice how the smoke appears to whip around the tail wing, here?

STEP 32:
With Free Transform still active, Right-click inside the bounding box again, and choose Warp. Click inside the grid and drag down just a bit to give the fire trail a subtle curve, so it looks less straight and linear. Press Return (PC: Enter) to commit your transformation.
STEP 33:
Now, here is another layer style trick: Click on the Add a Layer Style icon and choose **Outer Glow**. Choose **Overlay** from the Blend Mode pop-up menu, then click on the color swatch and choose a hot orange color once again. Leave the Opacity set to 75% and increase the size to around 100 px. This will create a nice warm glow around the fire element.

STEP 34:
Next, let’s add some other special effects. Remember that particle brush we created in Chapter 1? If you didn’t create it, you can go and do that now, or you can use any particle brush you’d like. We are going to use this to create flying debris around the plane. Once the brush is selected, click on Brush Tip Shape on the left side of the Brush panel and set the size to around 175 px (this may vary depending on your document). Then, increase the Spacing to around 65%.
STEP 35:
Click on Shape Dynamics on the left, and set the Size Jitter and Angle Jitter to 100%. Then, click on Transfer on the left. Here, just increase the Opacity Jitter to 100%.

STEP 36:
Now, create a new blank layer at the top of the layer stack and then just use this brush to dab particles on different parts of the plane. Press X to toggle between the black and white colors to randomize the tones. Notice that I added some particles around the engine where the flames are coming out, and here, I’m adding some to the wing.
**STEP 37:**
Create another new blank layer and, from the Add a Layer Style icon’s pop-up menu, choose **Inner Glow**. Again, we want a hot orange color and set the blend mode to **Hard Light**. Also, lower the Opacity to around 60%.

**STEP 38:**
Now, click on Outer Glow on the left and, this time, choose a deeper orange, but set the Blend Mode to **Hard Light**. Also, drop the Opacity here to around 50%.
STEP 39:
We’re going to add some gun effects (they’re on the wings), so with the Brush tool selected, choose a standard round, soft-edged brush from the Brush Picker and set the size to be just a bit bigger than the guns themselves. With your Foreground color set to white, just dab in the three spots where the guns are located on the wing on the right. The layer style will add a hot glow around them.

STEP 40:
Get the Smudge tool from the Toolbox (it’s nested beneath the Blur tool) and then, in the Brush Picker in the Options Bar, click on the gear icon in the top right, choose Natural Brushes from the flyout menu, and just append this brush set. Choose the brush called Spray 56 Pixels. Set the Strength to 95% and turn on the Finger Painting checkbox.
STEP 41:
Now, click on each burst and drag in the direction they would be firing to create a muzzle flash. Again, the layer style will update the glow.

STEP 42:
Next, we’ll add some bullets. So, select a standard round, hard-edged brush from the Brush Picker. Then, in the Brush Tip Shape section of the Brush panel, drop the Roundness to 24% to make it more of an extreme oval. Then, increase the spacing all the way to 1000% and set the Size to around 15 px. Click on Shape Dynamics on the left and, under Angle Jitter, set the Control pop-up menu to Direction, so the dots will follow the direction of the brush.
STEP 43:
Create a new blank layer, click-and-drag it beneath the muzzle flash layer in the Layers panel, and change its blend mode to **Overlay**. Press **D** to set your Foreground and Background colors to their defaults of black and white, respectively. Press-and-hold the Shift key and click on the first burst, and then, using the flash line as guide, position the cursor at the edge of the image and click to paint the line. Do this for each flash to create an array of bullets.

STEP 44:
Get the Smudge tool, again. You can use the same brush tip we did a moment ago, but drop the Strength to around 50% and also turn off the Finger Painting checkbox in the Options Bar. Then, do the same as you did painting the bullets—press-and-hold the Shift key, click on one end, and then click on the other end. This will smear the bullets, creating a motion blur effect. I went ahead and made two passes on each line here.
**STEP 45:**

Now, let’s adjust the fire smart object. Double-click on the smart object thumbnail in the Layers panel to open the fire file. Using the same Smudge tool, smear the fire from left to right. Increase the brush size, so you can get it all, and do this to both layers. Save and close the file when you’re done and you will see the effect updated. Aren’t smart objects cool?!

To finish my overall design, I added a second plane with other smoke and fire effects. To see this how this part was created, watch an exclusive video tutorial over on the book’s companion webpage, mentioned in the book’s introduction.
A Hollywood Parody

So, I have my friends over in the U.K. to thank for this one. Glyn Dewis is a photographer/retoucher and a Photoshop World instructor. Along with his friend, photographer Dave Clayton, they are always putting together themed shoots based on Hollywood movies. A while back, Glyn posted some test shots for a shoot based on the movie Looper with Bruce Willis. Well, I just had to have a go at it and asked Glyn if he would let me use the images. At first, it was for fun, but it came out so cool. So, here you go. Enjoy! Thanks Glyn and Dave!

STEP ONE:
Start by pressing Command-N (PC: Ctrl-N) and creating a new document that’s 1500 pixels wide by 900 pixels tall at 100 ppi. Then, press D to set your Foreground color to black, and press Option-Delete (PC: Alt-Backspace) to fill the Background layer with black.

STEP TWO:
Select the Gradient tool (G) from the Toolbox and, in the Options Bar, choose the Foreground to Transparent gradient from the Gradient Picker and click on the Radial Gradient icon (the second icon to the right of the gradient thumbnail). Click on the Foreground color swatch and set the RGB colors to R: 0, G: 73, B: 125 in the Color Picker. Click OK. Click on the Create a New Layer icon at the bottom of the Layers panel to create a new blank layer and, starting roughly in the middle of the canvas, click-and-drag out a blue gradient.

Continued
STEP THREE:
Create another blank layer and set its layer blend mode to Soft Light. Press D, then X to set your Foreground color to white, and then create another gradient on this new layer starting in the same spot. This will enhance the glow in the center.

STEP FOUR:
Press Command-R (PC: Ctrl-R) to bring up the Rulers. With the Move tool (V), click on the horizontal ruler at the top and drag down a guide to the 7-inch mark (or 700-pixel mark, depending on what unit of measure your ruler shows). This will establish a horizon in the scene, but also sets the frame for the text below, which will be added last.
STEP FIVE:
With the background started, let’s work on the subjects themselves. Now, in addition to shooting the images, these guys actually posed for them, as well. This is Glyn assuming the role of Bruce Willis. This is right out of the camera, so we need to do a few things to get it Hollywood-worthy.

STEP SIX:
Normally, I would probably go ahead and extract the subject from the background first, but not this time. First, we are going to process it with a little HDR Toning. Yes, I also normally use this as a finishing touch, but sometimes you gotta try things a little differently. So, go under the Image menu, under Adjustments, and choose **HDR Toning**.
STEP SEVEN:
In the HDR Toning dialog, start by going to the Detail slider, in the Tone and Detail section, and pushing it up to around 150%. Go down to Saturation, in the Advanced section, and set that to 10. Go back up and drop the Exposure just a bit to compensate for the Detail increase. Then, up in the Edge Glow section, turn on the Smooth Edges checkbox and adjust the Strength and Radius sliders until you see something you like (I rarely ever have the Radius set lower than the Strength). Once you have it tweaked the way you like it, go ahead and click OK. You can see the result has much more detail and has a grungy sharpness to it.

STEP EIGHT:
Now, let’s extract the subject from the background. Get the Quick Selection tool (W) from the Toolbox and start painting over the subject to generate a selection of him. The selection should snap to the edges, since they are more defined as a result of the HDR effect. Continue until everything is selected—I am not worrying about the cord hanging from the hair dryer, though. Remember, as you paint in a new area to add to the selection, it might select a part of the background in the process. If that happens, just press-and-hold the Option (PC: Alt) key and paint back over the unwanted area to deselect it.
STEP NINE:
Once the selection is done, click on the Refine Edge button in the Options Bar. In the dialog, set the View Mode pop-up menu to On Black. I saw no real need to use the Refine Radius tool here, as the selection was pretty clean, so I just bumped up the Radius in the Edge Detection section for good measure. Also, bumping up the Contrast slightly will tighten up the selection a bit more—here, I set it to 5%. Finally, in the Output section, set the Output To pop-up menu to New Layer. Click OK when you’re done.

STEP 10:
With the first subject extracted, go ahead and copy-and-paste or click-and-drag this layer to the main background file we created earlier. Then, press Command-T (PC: Ctrl-T) to bring up Free Transform and scale and position him as you see here. Press Return (PC: Enter) to commit your transformation.
**STEP 11:**
Make a duplicate of this subject layer by pressing **Command-J (PC: Ctrl-J)**, then change the duplicate layer’s blend mode to **Multiply** and drop its Opacity to 75%.

**STEP 12:**
Press **Command-U (PC: Ctrl-U)** to bring up the Hue/Saturation dialog. Turn on the Colorize checkbox, set the Hue to 200, and set the Saturation to 40. Also, bump up the Lightness to 25. This will apply a blue cast over the subject, making him fit in the scene a little better. I use this method often to manipulate the temperature of an image composited in a scene. Notice the difference just by toggling this layer on and off by clicking on the Eye icon to its left (I turned off the rulers here by pressing **Command-R (PC: Ctrl-R)**).
STEP 13:
Now, open the second shot. This one is of Dave with his lethal banana. Same process as before: First, go ahead and run the HDR Toning (under the Image menu, under Adjustments).

STEP 14:
The order in which I adjusted the settings is the same, but because it’s a different subject, some of the settings vary (you can see them all here). Click OK when you’re done.
STEP 15:
Again, like before, use the Quick Selection tool to generate a selection of the subject. Then, bring up the Refine Edge dialog. Now, this time, I did utilize the Refine Radius tool because Dave had some hair that I needed to refine—I just touched up a little part in the front of his head. I also bumped up the Radius (in the Edge Detection section) ever so slightly for good measure, once again. Just remember to set the Output To popup menu to **New Layer** and click OK.

![Refine Edge](image)

STEP 16:
Now, go ahead and place this subject in the main file, as well, but place this layer below the first subject layer in the Layers panel. Then, use Free Transform to scale him to fit in the composition in relation to the first character. Press **Return (PC: Enter)** when you’re done.

![Scaled Subject](image)
STEP 17:
Make a duplicate of this layer, change its blend mode to Multiply, and leave its Opacity set to 100%.

STEP 18:
Press Command-U (PC: Ctrl-U) to bring up Hue/Saturation, again. Turn on the Colorize checkbox, set the Hue to 200 and the Saturation to 40, but set the Lightness at 10 this time. Click OK. This applies a similar color cast to this subject, but it's actually a little darker, which creates a sense of atmospheric perspective and creates a separation between them.
STEP 19:
Now, with the top layer of the second subject still active, click on the Create a New Layer icon to create a new blank layer in between the two subject layers in the Layers panel. Then, click on your Foreground color swatch and set the RGB numbers to R: 11, G: 149, B: 182 in the Color Picker. Click OK.

STEP 20:
Get the Gradient tool again and, using the blue color we just used and with the same settings we used earlier, add a gradient to create a subtle blue haze between the subjects. Do this two or three times in that area.
STEP 21:
Okay, so now we need to select all the subject layers and the gradient layer we just made. So, click on the top one, then press-and-hold the Shift key and click on the bottom one. Remember, just the subjects and the gradient layer between them should be selected. Then, from the Layers panel’s flyout menu, choose New Group From Layers. This will place all those selected layers in a folder in the Layers panel. This allows you to treat the group as one layer, even though they are still individual layers inside. I just went ahead and named the group “Subjects,” here.

STEP 22:
Click on the Add Layer Mask icon at the bottom of the Layers panel to add a layer mask to the group. We’ll get back to this in a moment.
STEP 23:
With the Gradient tool still selected, press D to set your Foreground color to black, then in the Options Bar, leave the Foreground to Transparent gradient selected, but click on the Linear Gradient icon (the first icon to the right of the gradient thumbnail) this time. Create a new blank layer at the top of the layer stack, then click right on the guide we created earlier, and drag the gradient up just a little bit. This will black out the bottom area for the text we’ll add later and has a subtle fade up effect.

STEP 24:
Now we need a particle brush. Remember the one we created back in Chapter 1? I used the same technique here to create a more scattered particle brush from this video clip of someone throwing sand in front of a black background. I just captured the frame, then processed it into a custom brush. Refer back to Chapter 1 to see how to create the brush.
STEP 25:
Once the brush is selected, open the Brush panel (click the little folder with brushes icon next to the brush thumbnail in the Options Bar), then click on Shape Dynamics on the left and just increase the Angle Jitter to around 18%.

STEP 26:
Now, click on the layer mask we applied to the Subjects layer group. With your Foreground color set to black, just dab a few times to mask the subjects with the particle brush. Don’t go crazy, though—just a few dabs should do (I removed the guide here by going under the View menu and choosing Clear Guides).
**STEP 27:**
Create a new blank layer and move it just above the group layer in the layer stack. Using the same brush and black Foreground color, start in the middle and start painting in a small oval pattern, and you will see the particle effect build up. Again, don’t go too crazy. And, don’t be afraid to delete the layer and try again a few times until you get it the way you like it.

**STEP 28:**
Press X to set your Foreground color to white, then go up to the Options Bar and change the tool’s blend Mode to **Soft Light**. Starting a little bit lower than before, dab a few times to add some lighter areas of particles. In the Soft Light blend mode, it will ignore the darker areas and only apply in the lighter areas, thus making it appear as though the lighter particles are behind the darker ones.
**STEP 29:**
Here, we have a cityscape image to add to the background. You’re free to use this one or any other city skyline image you may have. Either way, go ahead and copy-and-paste or click-and-drag the image into the main design file and move it down in the layer stack right beneath the Subjects layer group.

**STEP 30:**
Press **Command-T (PC: Ctrl-T)** to bring up Free Transform, scale the image down, and position it to the left of the subjects. Line up the horizon line of the image with the edge of the gradient we created earlier (as seen here). Press **Return (PC: Enter)** to commit your transformation.
STEP 31:
Open the Hue/Saturation dialog by pressing **Command-U (PC: Ctrl-U)** or going under the Image menu, under Adjustments. Turn on the Colorize checkbox, set the Hue to 198, the Saturation to 38, and the Lightness to 12, and click OK.

STEP 32:
Change this layer’s blend mode to **Hard Light** and then click on the Add Layer Mask icon to add a layer mask to it. Get the Gradient tool, again, and with its current settings (the Foreground to Transparent gradient selected in the Gradient Picker, the Linear Gradient icon selected in the Options Bar, and the Foreground color set to black), add gradients to the layer mask coming in from the top and left side to fade the hard edges.
**STEP 33:**
Make a duplicate of this layer by pressing **Command-J (PC: Ctrl-J)**, then press-and-hold the Shift key and click-and-drag this duplicate layer to the other side of the subjects. Drag it just enough that the tallest tower goes out of frame, so it isn’t immediately obvious that it is a repeat.

**STEP 34:**
Create another new blank layer and place it above the particle effect layer. With the Gradient tool still selected, click on the Foreground color swatch and choose a bright blue color (like the one I am using here) from the Color Picker. Keep the Foreground to Transparent gradient selected in the Gradient Picker, but click back on the Radial Gradient icon in the Options Bar. Then, change this layer’s blend mode to **Soft Light**. This will help blend the particles a little bit more. Now, create a gradient in the center of the image near the bottom.

Continued
STEP 35:
One more thing to add is this cool high-tech background. I want it to be a rather subtle effect in the background. This particular one is a stock image and I have to say I hate the color, but you cannot let that turn you off. After all, we’re using Photoshop—we control the color. So, when you see an image you think is lame, take a closer look. You may see something no one else does.

STEP 36:
Go ahead and press **Command-Shift-U** (PC: **Ctrl-Shift-U**) to remove the color information, or you can go under the Image menu, under Adjustments, and choose **Desaturate**.
STEP 37:
Next, press **Command-L (PC: Ctrl-L)** to bring up Levels, or you can select it from the Adjustments menu, as well. Click on the black Eyedropper tool below the Options button, then move your cursor over the image, over one of the darker gray areas, and click once. This will force all grays in that range or darker to black, thus enhancing the lighter areas with greater detail and contrast. Click OK.

STEP 38:
Now, bring this new image over to the main design file, then use Free Transform to scale it, and position it on the left side of the image, partially covering Glyn.
STEP 39:
Move this layer down in the layer stack beneath the Subjects layer group, then change its layer blend mode to **Color Dodge** and drop its Opacity to 25%.

STEP 40:
Duplicate the layer by pressing **Command-J (PC: Ctrl-J)**. Then, go under the Edit menu, under Transform, and choose **Rotate 180°**. Now, just slide this layer over to the right, so you can see some of the grid elements on the other side. There you have it! In the final image I added some type, with a flare effect behind it, at the bottom of the image. I used the flare brush we created in Chapter 1 (on a separate layer), and just used Free Transform to stretch and squash it.
Chapter 4A Photographer/Designer Collaboration
INDEX

3D effects, 249–335
  graphic effects, 272–281
  logo effects, 282–312
  placing 3D in a photo, 261–271
  product shots, 313–335
  virtual macro effects, 250–260
3D layers
  merging, 254, 278, 297, 302, 308, 325, 327
  selecting, 254, 297
3D menu
  Merge 3D Layers option, 254
  New 3D Extrusion from Selected Layer option, 251, 263, 291, 301, 308
  New 3D Extrusion from Selected Path option, 276, 284, 295, 316, 319
  Render option, 260, 271, 304, 311, 334
  Split Extrusion option, 269
3D panel, 251
  Current View options, 263, 280, 281, 303, 316, 326
  Default Camera view, 299, 304, 318, 326, 327
  Environment options, 252, 256, 260, 265, 267, 272, 280, 289, 328
  Filter By: Lights icon, 257, 271, 272, 310, 331
  Filter By: Whole Scene icon, 258, 276, 310, 332
  See also Properties panel (3D effects)
3D rendering, 260, 267, 271, 304, 311, 334
3D tools
  Drag the 3D Object tool, 254, 264
  Rotate the 3D Object tool, 259, 260, 267, 277, 284, 290, 298, 316, 331
  Slide the 3D Object tool, 259, 264, 298, 316, 327
  50% Gray fill option, 124, 153, 197, 219

A
Add Layer Mask icon, 116, 118
adjustment layers
  Gradient Map, 31, 107
  Hue/Saturation, 36
Adobe Typekit, ix
Align to Canvas option, 231
aligning
  3D objects, 326
  layers, 190
  paths, 231
Alpha channel, 14
Angle Jitter setting, 30, 155, 161, 164, 179
Angle lighting setting, 219, 220, 234
anti-alias noise removal, 152
Arc Lower/Upper text options, 236, 237
Auto-Align Layers command, 190
axis widget, 269, 270, 278, 298, 302, 308, 309

B
Background color
  setting to default, 31, 122, 230
  swapping with Foreground color, 32, 118
Background color swatch, 224, 228
Background layer
  duplicating, 88, 106, 138, 316
  filling with color, 46, 64, 71, 144, 167, 208
  hiding, 21, 35, 95, 155
  unlocking, 282
backgrounds
  design elements extracted from, 11–16, 148–150, 238
  people extracted from, 2–10, 170–171, 174, 192, 200–201, 207
beer label project, 115–135
Bend radio button, 322
Bevel & Emboss layer style
  design effects and, 100, 103, 105
  Hollywood poster effects and, 233
  type effects and, 50, 51, 81
black backgrounds
  extracting design elements from, 11–12
  perforated pattern effect and, 98
  white smoke on, 204
black-and-white conversions, 107
Blend If options, 62, 91, 147, 237, 240
blend modes
  Color, 120
  Color Burn, 49, 90, 106, 219, 241
  Color Dodge, 81, 119, 186, 216
  Dissolve, 70, 114
  Hard Light, 124, 154, 155, 221
  Linear Burn, 36, 52, 90
  Linear Light, 52, 123, 220
  Multiply, 34, 48, 100, 172, 175, 197, 282
  Normal, 116
  Overlay, 25, 33, 49, 99, 146, 194
  Screen, 39, 64, 111, 156
  Soft Light, 10, 42, 88, 148, 195
  Vivid Light, 154
Blending Options dialog, 38, 60, 91, 98, 147, 237, 240
blur effects
  motion blur, 165
  surface blur, 136
Bracket keys ([ ]), 3, 8
branding effect, 88–92
Brown, Russell, 190
Brush panel, 30, 55, 155, 164
Brush Picker, 10, 29, 37, 54, 164
Brush Tip Shape settings, 55, 160, 164
Brush tool
  custom brushes and, 28
  effect creation with, 155
  painting on layer masks with, 118, 123, 191, 208
  retouching images with, 10
brushes
  creating custom, 23–30, 205
  Direction option, 164
  flare brush, 23–26, 186
  resizing, 3, 59
  tip shape of, 55, 160, 164
bump map, 254–255, 288, 296
Burn tool, 124, 154
chalkboard effect, 54–63
channels
  duplicating, 109, 120
  extracting elements using, 11, 13, 243
  as selections, 11, 121, 243
Channels panel, 11, 13, 20, 109, 120, 307
Character panel, 47, 73, 262
cityscape background, 181
Clayton, Dave, 167
Clear Guides option, 78, 179, 234
clipboard
  copying images to, 209, 265
  copying shapes to, 232
Clone Stamp tool, 216
color
  B&W images from, 107
  filling layers with, 15, 146, 208
  HDR toning effect and, 43
  removing from images, 24, 27, 79, 106, 184, 255
  sampling from images, 120
text, 76, 301
Color blend mode, 120
Color Burn blend mode
  design effects and, 90, 106
  Hollywood effects and, 219, 241, 246
type effects and, 49
Color Dodge blend mode
  design effects and, 119
  Hollywood effects and, 186, 216
type effects and, 81
Color Picker, 76–77, 130, 146, 176, 208, 213
Colorize checkbox, 36, 43, 109, 140, 148, 172, 210
columns, text, 71–78
Concepcion, RC, 206
Contour Editor, 286, 296, 318
contrast adjustments, 9
calculations
  color to black-and-white, 107
  layer to Smart Object, 53, 62, 98, 158, 235
Convert Point tool, 314
Coordinates icon, 263, 309, 310, 324
Index

338

copying
  creating new Smart Objects via, 101
  images to the clipboard, 209, 265
  selections to new layers, 12, 19, 21, 35, 111, 202
  shapes to the clipboard, 232
See also duplicating

Crayon brush, 54
Create a New Layer icon, 15
Create New Path icon, 315
Crop tool, 206, 261
cropping images, 206
custom brushes, 23–30, 205

Dafont.com website, ix, 79
dark backgrounds
  extracting subjects from, 2–6
  See also black backgrounds
Decontaminate Colors checkbox, 4, 9, 207
Default Camera view, 299, 304, 318, 326, 327
Define Pattern command, 47
Deform settings, 300, 321–322
Deformation Axis grid, 291, 321
Defringe command, 5, 152, 193, 217, 239
desaturate command, 184, 255
deselect command, 60, 121, 130, 219, 329
design effects, 87–141
  branding effect, 88–92
  building a beer label, 115–135
  designing with textures, 106–114
  perforated pattern effect, 93–105
  video game effect, 136–141
Dewis, Glyn, 167
Diffuse color swatch, 268, 293, 294
Diffuse setting, 256, 332
Displace filter, 92
displacement map, 91–92
Dissolve blend mode, 70, 114
distorting images, 159
document creation, 24, 32
Dodge tool, 124, 197

Doorhof, Frank, 272
Drag the 3D Object tool, 254, 264
Drop Shadow layer style
  3D logo effect and, 311
  design effects and, 90
  Hollywood poster effects and, 234, 241, 246
Duplicate Image dialog, 196
duplicating
  Background layer, 88, 106, 138, 316
  channels, 109, 120
  images, 40, 91, 196, 200, 221, 333
  layers, 5, 22, 117, 126, 147
See also copying

Edge Detection Radius setting, 4, 8, 125, 171, 193
edges, refining, 4, 8, 125, 193
Edit Texture option, 328, 332
Ellipse tool, 231, 274
Elliptical Marquee tool, 83, 94
Erase Refinement tool, 8
Eraser tool, 35, 61, 120, 216
erodible brush tips, 54, 56
extractions
  bonus techniques for making, 17–22
  design element from background, 11–16, 148–150, 238
  people from background, 2–10, 170–171, 174, 192,
    200–201, 207
Extrusion Depth setting, 251, 253, 264, 276, 285, 291, 317
Eye icon, 12, 21, 35
Eyedropper tool, 120, 185

Fade dialog, 138
file size for projects, x
Fill dialog, 46, 95, 124, 144, 197
Fill Opacity slider, 98
filling
  Background layers, 46, 64, 71, 144, 167, 208
  layers with 50% Gray, 124, 153, 197, 219
  layers with color, 15, 146
selections, 15–16, 46, 68, 78, 81, 95
text, 76, 301
Filter By: Lights icon, 257, 271, 272, 310, 331
Filter By: Whole Scene icon, 258, 276, 310, 332
Filter Gallery, 107
filters
  Displace, 92
  Grain, 107, 137
  Minimum, 85
  Poster Edges, 137
  Surface Blur, 136
  Twirl, 330
Finger Painting feature, 37, 163
fire effects, 155–160, 243–246
flare brush, 23–26, 186
Flatten Image command, 91, 196, 221
Flip Horizontal option, 128, 194
Flip Vertical option, 212
Flip X/Y Jitter checkboxes, 30
flipping images, 194, 212
fonts
  for 3D shapes, 290
  resource for free, ix
  See also text; type effects
Ford, Brandon, 206
Foreground color
  setting to default, 31, 122, 230
  swapping with Background color, 32, 118
Foreground color swatch, 56, 130, 146, 203
Foreground to Background gradient, 224
Foreground to Transparent gradient
  3D product shots and, 329
  custom brush creation and, 25
  design effects and, 110, 113, 116, 127
  Hollywood effects and, 198, 204, 212, 224, 227, 228, 238
  photographer/designer collaborations and, 153, 167
  texture backgrounds and, 33
  type effects and, 64
Fotolia.com, 200, 250
FOV (Field of View) setting, 258, 311
Free Transform
  distorting images with, 159
  flipping images with, 194, 212
  positioning images with, 212
  resizing images with, 127, 195, 203, 227
  rotating images with, 89, 108, 131
  scaling images with, 19, 32, 151, 171, 174, 181, 209, 232
  showing the corner handles in, 32, 194, 203
  stretching text vertically with, 235
  warping elements with, 159, 236, 245
fx icon, 103, 221
G
Garcia, Viktor, 136
Giard, Shelley, 115
Gradient Map adjustment layer, 31, 107
Gradient Overlay layer style
  3D logo effects and, 282
  design effects and, 100
  Hollywood poster effects and, 234, 240
  photographer/designer collaborations and, 146
  type effects and, 49, 52, 83
Gradient Picker, 25, 110, 153, 167
Gradient tool, 25, 33, 64, 110, 153, 167, 176, 198
gradients
  Foreground to Background, 224
  Foreground to Transparent, 25, 33, 64, 110, 153, 198, 329
  Linear, 25, 83, 110, 116, 146, 259
  Quick Mask mode used on, 118
  Radial, 33, 64, 128, 153, 167, 198, 204
Grain filter, 107, 137
graphic effects in 3D, 272–281
grid lines
  setting up, 93
  snapping to, 94
  See also guides
Gritty Gangster movie poster, 200–205
gritty overlay effect, 40–43
Ground Plane settings, 252, 272, 277, 280, 285, 334
grouping layers, 177
guides
  clearing, 78, 179, 234
  setting, 71, 94, 168, 231
  snapping to, 231
  See also grid lines

H
Hard Light blend mode
  design effects and, 124
  Hollywood poster effects and, 221, 241
  photographer/designer collaborations and, 154, 155, 162, 182
HDR Toning feature
  gritty overlay effect and, 40–43
  Hollywood effects and, 169–170, 173, 196, 201, 221–222
Hide All layer mask, 118
hiding layers, 21, 35, 95
high-tech background effect, 184
Hollywood effects, 189–247
  Gritty Gangster poster, 200–205
  Hollywood Parody effect, 167–187
  Iron Man text effect, 79–85
  Nosferatu’s double poster, 190–199
  Photoshop World poster, 226–247
  Shabang poster, 206–225
Horizontal Angle slider, 322
Horizontal Type tool
  3D effects and, 262, 300
  columns of text and, 72
  design effects and, 104, 112
  Hollywood poster effects and, 235
  Iron Man text effect and, 79
  movable type effect and, 47
  type in negative space and, 65
Hue setting
  design effects and, 140
  HDR image effects and, 43
  Hollywood poster effects and, 210, 218, 223
  photographer/designer collaborations and, 148, 172, 175, 182
  textures and, 36, 109
Hue/Saturation adjustment layer, 36
Hue/Saturation dialog
  design effects and, 109, 139, 140
  HDR image effects and, 43
  Hollywood poster effects and, 210, 218, 223, 239
  photographer/designer collaborations and, 148, 172, 175, 182
  texture effects and, 109
Hurley, Peter, 206

I
IBL (Image Based Light) options, 256, 260, 265, 272, 289–290, 328
Ignis, Mick, 190
images
  copying, 209, 265
  cropping, 206
  desaturating, 184, 255
  distorting, 159
  duplicating, 40, 91, 196, 200, 221, 333
  flipping, 194, 212
  inverting, 14, 26, 80, 255, 293, 333
  merging, 191
  noise removal, 152
  positioning, 212
  resizing, 127, 195, 203, 227
  rotating, 89, 108, 131, 186, 213, 215, 305
  sampling color from, 120
  scaling, 19, 32, 151, 171, 209, 232
  stock, xi
  unlinking/relinking, 213
  warping, 159, 245
Inflate settings, 253
Inner Glow layer style
  fire trail effects and, 155, 160, 162
  type effects and, 49, 82
Inner Shadow layer style, 154, 219
Instance Object feature, 279, 309
inversing selections, 4, 21, 35, 69, 70, 84, 95
inverting images, 14, 26, 80, 255, 293, 333
Iron Man text effect, 79–85
Kelby, Scott, 261
kelbyone.com website, ix, xi
kerning adjustments, 262

Lasso tool, 17, 121, 123, 131, 150, 245, 305–306
lathing process, 321
layer masks
  applying to layers, 217
  creating new layers with, 9, 207
design effects and, 116, 118, 123, 127
Hollywood effects and, 191, 205, 208, 227
photographer/designer collaborations and, 177, 182
type effects and, 85
Layer Style dialog, 48, 60, 97, 282
layer styles
  Bevel & Emboss, 50, 51, 81, 100, 233
  Drop Shadow, 90, 234, 241, 246, 311
  Gradient Overlay, 49, 52, 83, 100, 146, 234, 282
  Inner Glow, 49, 82, 155
  Inner Shadow, 154, 219
  Outer Glow, 52, 90, 156, 241
  Pattern Overlay, 48, 81, 97, 99, 101–102
  Stroke, 82
layers
  auto-aligning, 190
  converting to Smart Objects, 53, 62, 98, 158, 235
creating new, 46
  duplicating, 5, 22, 117, 126, 147
  filling with color, 15, 146
  grouping, 177
  hiding, 21, 35, 95
  merging, 5, 126, 139, 151, 232
  opacity setting for, 84, 124, 199
  removing color from, 147, 124, 199
  shape, 102–103
  See also 3D layers; adjustment layers; Background
  layer
lenses for 3D effects, 258
Levels dialog adjustments
  3D effects and, 255, 262
  background images and, 185
custom brush creation and, 24, 27
design effects and, 110, 120, 122, 126
Hollywood effects and, 202, 222
image extractions and, 14
type effects and, 80
light backgrounds
  extracting subjects from, 7–10
  See also white backgrounds
lighting angle adjustments, 219, 220, 234
Lightness setting
  HDR image effects and, 43
  photographer/designer collaborations and, 172, 175, 182
texture effects and, 109
Line Cap Type pop-up menu, 275
Linear Burn blend mode, 36, 52, 90
Linear Dodge Highlight Mode, 81
Linear gradients, 25, 33, 110, 116, 146, 259
Linear Light blend mode, 52, 123, 220
link icon, 213
Live Shape Properties, 275
Load Path as Selection icon, 67, 68
Load Selection dialog, 111, 121
Load Texture option, 255, 287, 288, 294, 334
logo effects in 3D, 282–312
luminosity selections, 129–130
macro effects with 3D, 250–260
Magic Wand tool, 34
marble texture image, 79
Matting feature, 5, 12
McCormick, Mia, 206
merging
  3D layers, 254, 278, 297, 302, 308, 325, 327
  images, 191
  layers, 5, 126, 139, 151, 232
Midtones Range option, 124, 154
Minimum filter, 85
motion blur effect, 165
movable type effect, 46–53
Move to View button, 273, 331
Move tool
  copying parts of images using, 211
dragging-and-dropping using, 89, 115, 190, 202, 252
positioning text with, 104
movie posters
  Gritty Gangster, 200–205
  Nosferatu’s double, 190–199
  Shabang, 206–225
  See also Hollywood effects
Multiply blend mode
  3D logo effects and, 282
design effects and, 100, 108, 117, 126, 138
Hollywood effects and, 197, 210, 213, 218, 223, 234
photographer/designer collaborations and, 172, 175
texture effects and, 34
type effects and, 48, 82, 83

N
naming/renaming
  objects in 3D panel, 285, 324
  patterns, 48, 80, 96
Natural Brushes option, 37, 163
negative space, type in, 64–70
New 3D Extrusion from Selected Layer option, 251, 263, 291, 301, 308
New 3D Extrusion from Selected Path option, 276, 284, 295, 316, 319
New Layer with Layer Mask option, 9
New Smart Object via Copy command, 101
New Tool Preset dialog, 56
noise removal, 152
Normal blend mode, 116
Nosferatu’s double movie poster, 190–199

O
opacity
  fill, 98, 220
  layer, 84, 124, 199
    Opacity Jitter setting, 30, 161
    Opacity slider, 98
    Outer Glow layer style
      design effects and, 90
      fire trail effects and, 156, 160, 162
      Hollywood effects and, 241
type effects and, 52
    Output To pop-up menu, 19, 125, 174, 201
    Overlay blend mode
      Brush tool, 28
custom brush effects and, 25
design effects and, 99, 138
Hollywood effects and, 194, 197, 198, 203, 208, 215, 218, 229
photographer/designer collaborations and, 146, 147, 160, 165
texture effects and, 33
type effects and, 49, 65, 70

P
Paragraph panel, 74
Paste command, 24, 209, 266
Path Alignment icon, 231
Path Operations icon, 231, 233
Path Selection tool, 60, 66, 231, 232
paths
  shape, 230–231, 283, 314–315
type, 58, 59, 60, 66–67, 68, 70
Paths panel, 58, 59, 61, 66, 67, 283, 314
Pattern Name dialog, 80
Pattern Overlay layer style
  design effects and, 97, 99, 101–102
type effects and, 48, 81
Pattern Picker, 48, 81, 101
patterns
  naming, 48, 80, 96
  perforated, 93–105
transparent areas in, 96
  See also textures
Pegg, Simon, 226
Pen tool, 315
perforated pattern effect, 93–105
Peterson, Moose, 144
photographer/designer collaborations, 143–187
  Going Down in Flames effect, 144–166
  Hollywood Parody effect, 167–187
photos
  placing 3D effects in, 261–271
  See also images
Photoshop World poster, 226–247
Pillow Emboss option, 51
Point at Origin button, 258
Point Light option, 310, 331
positioning
  images with Free Transform, 212
  text with the Move tool, 104
Poster Edges filter, 137
Posterize dialog, 138
Preferences, Photoshop, 93
presets
  brush, 26, 28–29
  tool, 56
product shots in 3D, 313–335
projects
  file sizes for, x
  fonts used in, ix
Properties panel (3D effects)
  Cap icon, 253, 277, 286, 292, 296, 317
  Coordinates icon, 263, 309, 310, 324
  Deformation Axis grid, 291, 321
  Depth of Field settings, 280
  Diffuse color swatch, 268, 293, 294
  Extrusion Depth setting, 251, 253, 264, 276, 285, 291, 317
  Ground Plane settings, 252, 272, 277, 280, 285, 334
  IBL options, 256, 260, 265, 272, 289–290, 328
  Inflate settings, 253
  Live Shape Properties, 275
  opening in 3D workspace, 251
  Point at Origin button, 258
  See also 3D panel
Properties panel (Hue/Saturation), 36
Q
Quick Mask mode, 118
Quick Selection tool
  design effects and, 116, 122, 125, 139
  extracting subjects from backgrounds with, 3, 7, 149, 170, 174, 192, 200–201, 207, 238
R
Radial Gradient icon, 118, 153, 183, 198, 204, 330
Radial gradients, 33, 64, 128, 153, 167, 198, 204
Rectangle tool, 230
Rectangular Marquee tool, 46, 78, 94, 124, 211, 214, 227, 329
Refine Edge dialog, 4, 8, 18, 125, 150, 171, 174, 192
Refine Radius tool, 4, 8, 18, 150, 174, 192, 207
Reflection setting, 256, 266, 287, 323–324, 325
Remove Black Matte option, 12, 244
removing
  anti-alias noise from images, 152
  color from images, 24, 27, 79, 106, 184, 255
renaming. See naming/renaming
rendering 3D effects, 260, 267, 271, 304, 311, 334
Replace Texture option, 256, 289, 332
resizing. See sizing/resizing
RGB channel, 11, 15, 20, 121, 129, 204
Rohrmann, Adam, 115
Rotate the 3D Object tool, 259, 260, 267, 277, 284, 290, 298, 316, 331
rotating
  images, 89, 108, 186, 213, 215, 305
  shapes, 131, 133, 134
Rotation angle settings, 263, 309, 310, 324
Rounded Rectangle tool, 102, 313, 315
rulers, 71, 93, 94, 168, 231
  See also guides
S
sampling colors, 120
Saturate mode, 117
Saturation setting
  design effects and, 140
  HDR image effects and, 43
Saturation setting (continued)
  Hollywood poster effects and, 210, 223, 239
  photographer/designer collaborations and, 148, 172, 175, 182
  textures and, 36, 109
Save Path dialog, 66
scaling
  images, 19, 32, 151, 171, 209, 232
  text, 235
  See also sizing/resizing
Screen blend mode
  design effects and, 111, 122, 132, 133
  fire trail effects and, 156
  texture effects and, 39
  type effects and, 64
Select All command, 209
selections
  channels as, 11, 121, 243
  copying to new layer, 12, 19, 21, 35, 111, 202
  entire canvas, 148
  filling, 15–16, 46, 68, 78, 81, 84, 95
  inversing, 4, 21, 35, 69, 70, 84, 95
  luminosity, 129–130
  quick, 3, 7, 116, 149
  soft-edged subject, 17–19
  transparent area, 20–22
Shabang movie poster, 206–225
shadows
  3D effect, 252, 263, 271
  See also Drop Shadow layer style
  shadows Eyedropper, 24, 202, 262
  Shape Dynamics options, 30, 155, 161, 164, 179
  shape layers, 102–103
  Shape Stroke Type pop-up menu, 275
shapes
  brush tip, 55, 160, 164
  converting to 3D, 308
  copying, 232
  paths for, 230–231, 283, 314–315
  rotating, 131, 133, 134
  swirly, 129, 133, 305
warping, 132
Shine setting, 256, 266, 287, 323–324, 325
side lighting effect, 219
Size Jitter setting, 30, 155, 161
sizing/resizing
  brushes, 3, 59
  images, 127, 195, 203
  text, 74, 75
  See also scaling
Slide the 3D Object tool, 259, 264, 298, 316, 327
Smart Objects
  adjusting effects using, 166
  converting layers to, 53, 62, 98, 158, 235
smoke trail effect, 157–158
smoking gun effect, 204–205
Smooth Edges checkbox, 222
Smudge tool, 37, 163, 165, 166
Snap To feature, 94, 231
Soft Light blend mode
  Brush tool, 10
  design effects and, 88, 104
  HDR toning effect and, 42
  Hollywood poster effects and, 195, 199, 214, 224, 230, 240
  photographer/designer collaborations and, 148, 152, 168, 180, 183
soft-edged subjects, 17–19
Speckle Grain filter, 137
Split Extrusion option, 269
Sponge tool, 117
Spot light effect, 257–258
stock images, xi
stretching text, 235
Stroke color swatch, 274
Stroke layer style, 82
Stroke Path dialog, 58
Surface Blur filter, 136
swirly elements, 129, 133, 305
T
  Taper setting, 300
text
centering in text block, 74
chalkboard effect, 54–63
color, 76, 301
columns of, 71–78
filling, 76, 301
Iron Man effect, 79–85
movable type effect, 46–53
in negative space, 64–70
paths, 58, 59, 60, 66–67, 68, 70
positioning with Move tool, 104
scaling to fit, 235
sizing/resizing, 74, 75
stretching, 235
warping, 63, 236, 237, 290
See also type effects
text boxes, 72
textures
background, 250
designing with, 106–114
editing, 328, 332
Hollywood effects and, 199, 229–230, 232
loading for 3D effects, 255, 287, 288, 294, 334
mixing for background effect, 31–39
movable type effect, 47–48
naming patterns and, 48, 80
transparent areas in, 96
See also patterns
Transform options
Flip Horizontal, 128
Rotate, 186, 213, 215
Warp, 63
See also Free Transform
transparent areas
extracting with subjects, 20–22
textures/patterns with, 96
Trash icon, 58, 68, 221, 333
tutorials
project-based, xii
video, ix, 166, 334
Twirl filter, 330
type effects, 45–85
chalkboard effect, 54–63
column of text, 71–78
Iron Man text effect, 79–85
movable type, 46–53
type in negative space, 64–70
See also text
U
Underlying Layer slider, 158, 237
unlinking/relinking images, 213
V
Vector Mask options, 232
video frame captures, 144–145
video game effect, 136–141
video tutorials, ix, 166, 334
virtual macro effects, 250–260
Vivid Light blend mode, 154
Von Cromer, Ian, 190
W
warping
images, 159, 245
shapes, 132
text, 63, 236, 237, 290
Web resources, ix, xi
white backgrounds
black graphics on, 129
extracting design elements from, 13–16
wireframes for 3D objects, 332
The World’s End movie poster, 226
X
X Rotation angle, 263, 309, 310
Y
Y Rotation angle, 324
Z
Z Rotation angle, 324
Zoom tool, 17, 117